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Getting Started

Introduction

This User Manual applies to all civil actions filed August 1, 2001, and thereafter.
Beginning August 1, 2001, all newly filed civil cases will be maintained in the
Electronic Case Files (ECF) System.

Practitioners should refer to W.D. Mich. LCivR 5.7 for guidance in Electronic Filing.

Pleadings or other documents which are filed traditionally rather than electronically
shall be served in the manner provided for in, and on those parties entitled to notice
in accordance with, the Federal Rules of Civil Procedure and the Local Rules of the
Western District of Michigan.

This manual provides instructions on how to use the Electronic Filing System to file
documents with the Court, or to view and retrieve docket sheets and documents for
all cases assigned to this system. It assumes a working knowledge of Netscape,
Internet Explorer and Adobe Acrobat.  For questions regarding Netscape, Internet
Explorer or Adobe Acrobat, please refer to their instruction manuals.  

Help Desk

If you need assistance, the Court’s Help Desk is available by telephone at
(616) 456-2206 or toll free at (800) 290-2742, or via email at
ecfhelp@miwd.uscourts.gov weekdays between the hours of 8:00 a.m. and
5:00 p.m.

Capabilities of System

The electronic filing system allows registered participants with Internet
access and Netscape or Internet Explorer software to perform the following
functions:  

• Access the Court’s web page
• Download the most recent version of the User’s Manual
• Train using a tutorial that mimics the process of e-filing
• Electronically file pleadings and documents in actual (“live”) cases
• View official docket sheets and documents associated with cases
• View various reports (e.g., Cases Filed Report, Calendar (for cases

filed electronically) )
• Download Netscape Browser and Portable Document Format (PDF)

configuration information
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Requirements

Hardware and Software Requirements

The hardware and software needed to electronically file, view and retrieve
case documents are the following:

• A computer running a Windows or Macintosh operating system

• Software to convert documents from a word processor format to
portable document format (PDF). 

• A PDF-compatible word processor like Macintosh or Windows-based
versions of WordPerfect and Word

• Internet access supporting a transfer rate of 28.8 kbs or higher

• Browser software (e.g. Netscape or Internet Explorer).  Please refer
to our website for the latest information regarding compatible browser
requirements.

• Access to a scanner to image documents you did not produce or
create (optional)

• A PACER account is required to retrieve information from the ECF
system. You can obtain a PACER account by calling (800) 676-6856
or by visiting the PACER registration page at
http://pacer.uscourts.gov/register.html  A link to PACER’s site is
provided on the Court’s web site.

How to Register for Access

Participation in electronic filing is limited to attorneys who are
members of the bar of this court.  Attorneys who have never used the
system must submit a completed Electronic Filing Registration Form
via hand delivery or U.S. mail only to

Clerk, U.S. District Court
E-Filing Registration
399 Federal Building
110 Michigan St., NW
Grand Rapids, MI 49503
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for processing.  The form is available on the Court’s website at
http://www.miwd.uscourts.gov, or they may telephone the Court’s Help
Desk at (616) 456-2206 or toll free at (800) 290-2742 to have the form
mailed to them.  Only after a user account has been established
based on the registration form, is the participant issued a login and
password that will provide access to the system.

For practice purposes, a tutorial is provided on the Internet at
http://www.miwd.uscourts.gov. It is strongly recommended that
participants take advantage of the tutorial before filing a document in
the “live” data base. 

Preparation

Setting Up the Acrobat PDF Reader

In order to view documents filed on the system, users must set up Acrobat
PDF reader. All pleadings must be in PDF format to be filed electronically.
When installing this product, please review and follow Adobe’s directions to
utilize an Acrobat PDF reader after installation.

Portable Document Format (PDF)

Only PDF (Portable Document Format) documents may be filed with the
Court using the Court’s Electronic Filing System. 

Be sure to view the PDF formatted document before
sending it to ensure that it appears in its entirety and in
the proper format.  

How to View a PDF File

• Start the Adobe Acrobat  program. 

• Go to the File menu and choose Open. 

• Click on the location and file name of the document to be
viewed. 

• If the designated location is correct, and the file is in PDF
format,  Acrobat loads the file and displays it on the screen.

• If the displayed document is larger than the screen or consists
of multiple pages, use the scroll bars to move through the
document. 
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• Click on the View menu for other options for viewing the
displayed document. Choose the option that is most
appropriate for the document.

How to Convert Documents to PDF Format

Conversion of any word processing document to PDF format is
required before submission to the Court’s electronic filing system. 

The conversion process is relatively simple and can be accomplished
in one of two ways depending on the word processing program you
are using.

For WordPerfect:

Version 6.1, 7, 8   (PDF Writer required for use with these versions)
• Open the document to be converted.  

• Select the Print option and in the dialog box select the option
to change the selected printer.  A drop down menu with a list
of printer choices is displayed.  

• Select Adobe PDFWriter. 

• “Print” the file. The file should not actually print out;  instead the
option to save the file as a PDF format file appears. 

• Name the file, giving it the file type extension .PDF . 

• Accept the option and the file is converted to a PDF document.

• The file is now in Adobe PDF format under the newly
designated name, and the original document remains in its
original form under the original name.

Version 9 or higher                                                                                
• Use above method or:

• Open the document. 

• Click on the File menu and select, Publish to PDF. 
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• Be sure that [all pages] or [full document] is selected on the
Document tab.

• Click on the Details tab and select, Publish Text as
Graphics.  (Note: This step reduces the resulting file size
considerably.  This will be important with regard to system
response time.)

• Save the file as a PDF file, giving it the file type extension
.PDF .

• The file is now in Adobe PDF format under the newly
designated name, and the original document remains in its
original form under the original name.

For Microsoft Word 95 or later (PDF Writer required for use with these
versions):

• Open the document. 

• Click on the File menu and select, Create Adobe PDF. 

• Save the file as a PDF file, giving it the file type extension
.PDF .

• The file is now in Adobe PDF format under the newly
designated name, and the original document remains in its
original form under the original name.

Any Other Word Processing Program:

• Open the document to be converted.  

• Select the Print option and in the dialog box select the option
to change the selected printer.  A drop down menu with a list
of printer choices is displayed.  

• Select Adobe PDFWriter. 

• “Print” the file. The file should not actually print out;  instead the
option to save the file as a PDF format file appears.  

• Name the file, giving it the file type extension .PDF . 
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• Accept the option and the file is converted to a PDF document.

Depending on the word processing program being used, it may
be necessary to find the printer selection option elsewhere.  At
that point, change the printer to Adobe PDFWriter, and follow the
directions above.

Basics

User Interactions

There are three general types of user interactions allowed by the system:

• Entering data

• Using command buttons to tell the system what to do
next

• Clicking on hyperlinks

Command buttons and hyperlinks are used to instruct the system what to do
next.

Documents Filed In Error 

A document incorrectly filed in a case may be the result of posting the
wrong PDF file to a docket entry, selecting the wrong document type
from the menu, or simply entering the wrong case number and not
catching the error before the transaction is completed.

The system will not permit you to make changes to the document(s)
(or the resulting docket entry) once the transaction has been
committed.  Once a document has been filed electronically it is part of
the Court record.  If the wrong document or a partial document is
filed in error, you are advised to re-file a corrected document.
Docket entries are the business of the clerk’s office and will not be
modified upon request.  The clerk’s office may edit a docket entry to
correct or clarify as the Clerk deems necessary.

Viewing Transaction Log 

This feature, selected from the Reports Menu off the blue bar, allows
you to review all transactions processed with your login and password.
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If you believe or suspect someone is using your login and password
without permission, change your password immediately, then contact
the Court’s Help Desk via telephone at (616) 456-2206 or toll free at
(800) 290-2742, or via email at ecfhelp@miwd.uscourts.gov as soon
as possible.

User Manual

The most recent version of the User Manual for the system is always
available in PDF format at the Court’s website at
http://www.miwd.uscourts.gov, under Electronic Filing.

A Step-By-Step Guide

Below is a step-by-step guide for entering the system, preparing a document for
filing, filing a motion or application, and displaying a docket sheet.  We suggest  that
you go through the steps in the tutorial before trying to actually file a document for
the first time.  

How to Access the System

Users can get into the system via the Internet (compatible browser software is listed
on the login screen) by going to:

http://www.miwd.uscourts.gov and clicking on ELECTRONIC FILING

Click on ECF System
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Logging In

The next screen is the login screen.

• Enter your Login and Password in the appropriate data entry fields.
Then click on the   button to transmit the information to the
system. If an error is made before you’ve submitted the screen, the

  button allows you to clear the Login and Password entries so
they may be re-entered.

• If an invalid combination has been submitted, the system responds

with an error message.  Click on  , then re-enter your Login and

Password.

• The entry of a valid Login and Password combination prompts the
system to display the main menu.

• For those current PACER users that have not registered as e-filers,
you may use your PACER login to view docket sheets and documents (you
must use your ECF login to file documents electronically).  Logging in using
your PACER login will give you a similar menu to that shown below, except
the Civil and Criminal options will not appear.
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The following screen is the main menu:
   

Note that the date you last logged into the system appears at the bottom
left of this screen.  

Last login: 08-27-2003 10:25 

27August2003

You should review this information each time you log in for security reasons.
If you believe or suspect someone is using your login and password without
permission, change your password immediately, then contact the Court’s
Help Desk via telephone at (616) 456-2206 or toll free at (800) 290-2742, or
via email at ecfhelp@miwd.uscourts.gov as soon as possible.

Civil Events Feature

This Civil option permits the filing of documents in a case.

There are four basic steps involved in filing a document:

(1) selecting a menu item (document event type);
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(2) entering the case number for which the document is to be filed;

(3) designating the parties filing the document; and

(4) specifying the PDF file name for the document to be filed.

Each screen has the following two buttons:

•   clears all characters entered in that particular box.  

•   accepts the entry just made and displays the next
entry screen, if any.

Correcting a Mistake

Use the  button on the browser toolbar to go back and correct

an entry made on a previous screen. However, once the document
is transmitted to the Court (the final submit button), only the
Court can make changes or corrections.  

Signatures

Attorneys

An attorney’s use of the court-issued login and password to submit
documents over the ECF system serves as the attorney’s signature
on all electronic documents filed with the Court, as well as the
attorney’s signature for purposes of Fed R. Civ. P. 11 and for all other
purposes under the Federal Rules of Civil Procedure and the Local
Rules of this Court.

Multiple Signatures

The filer of any document requiring multiple signatures (e.g.,
stipulations, joint status reports) must list on the document all of the
names of other signatories by means of an “s/____” block for each.
By submitting such a document, the filer certifies that each of the
other signatories has expressly agreed to the form and substance of
the document and that the filer has their actual authority to submit the
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document electronically.  The filer must maintain any records
evidencing this concurrence for subsequent production to the Court
if so ordered or for inspection upon request by a party until one year
after the final resolution of the action (including appeal, if any).

Service of Electronically Filed Documents

Summons and Initial Pleading

Service of the summons and complaint or other initial pleading must
be made by one of the methods allowed by Rule 4 of the Federal
Rules of Civil Procedure and may not be made electronically.

Subsequent Pleadings and Papers

Electronically filed documents are served on other registered counsel
in the case through the Notice of Electronic Filing (NEF) that is sent
immediately via email.  Service upon unregistered counsel and pro se
parties must be accomplished through traditional means (on paper),
by one of the ways allowed by Rule 5 of the Federal Rules of Civil
Procedure.  Traditionally filed documents must also be served by one
of the ways allowed by Rule 5 of the Federal Rules of Civil Procedure.
NOTE: If an electronically filed document must be served
traditionally, print the PDF version you filed electronically and
serve that.  Otherwise, line numbers and other formatting may
not match the official, filed version of your document.

Method of Electronic Service

When a document is filed electronically by a party, the Court’s system
will generate a Notice of Electronic Filing (NEF), which will be
transmitted by the Court via email to the filer and all attorneys who are
registered as e-filers.  The NEF will contain a hyperlink to the filed
document.  The party filing the document electronically should retain
a paper or digital copy of the NEF, which serves as the Court’s date-
stamp and proof of filing.  Transmission of the NEF for an
electronically-filed document to the registered email address
constitutes service of a pleading, paper, order or notice upon any
attorney who is a registered e-filer in the case.  After issuance of the
NEF, the general public as well as any party to the litigation may
access and download the filed document on the Court’s PACER
system except that access to Social Security cases is restricted to
attorneys of record.  Only service of the NEF by the Court’s system is
sufficient to constitute electronic service; transmission of a document
by one party to another by regular e-mail does not constitute service.
Effect on Time Computation
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Electronic service under Local Civil Rule 5.7 is complete upon
transmission.  The additional three days to do an act after service of
a document under Federal Rule of Civil Procedure 6(d) applies when
service is made electronically.

Filing Initial Papers

You must file the initial pleadings (complaint or petition), issue and serve the
summons, and make payment of initial filing fees in the traditional manner
(not electronically).  You are strongly encouraged to accompany your initial
filing (and all future paper filings) with a diskette or CD-ROM of your papers
in PDF format, so that these documents can be added to the electronic case
file.

Filing a Motion or Application

• Select Civil from the bar at the top of the main menu to bring up the
Civil Events window.

• Click on
Motions under  Motions and Related Filings



United States District Court, Western District of Michigan CM/ECF User Manual

15

• Select type of motion relief sought

Use the up and down arrows to the right of the white box to find the type
of motion or application to be filed, and click on it.

To select multiple motion reliefs, press and hold down the Ctrl key, and
click on the appropriate forms of relief sought. 

• Scroll down and click on .

• Enter the case number.

If the number is entered incorrectly, click  to re-enter.
or

If the computer prompts that you entered an invalid case

number, click on  to re-enter.

• When the case number is correct, click on .



United States District Court, Western District of Michigan CM/ECF User Manual

16

• Recheck whether the case number is correct, based upon the

case caption at the top of the screen.  If it is incorrect, click on  
to re-enter the case number.

• The next screen prompts you to select or add the name of the
party for whom you are filing the motion:

C lick on
the down arrow to the right of the box to scroll through the list (if
necessary).  If the name you're looking for appears, click on it, and then
click .

If the name does not appear, call the ECF Help Desk at (616) 456-2206 or toll free at (800)
290-2742.  The Clerk will advise you regarding the appropriate
steps to take, depending on the particular circumstances.  If
appropriate, click on Add/Create

New Party.
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The party may exist in the database even if not yet linked to the case.

When searching, type a minimum of the first two letters of the business
or individual’s last name.  

Note: Business names that begin with small words such as “The” or “A”
will be in the database with these words at the end of their name
separated by a comma (e.g., Michigan Network, The).

Click on . 

The computer displays a list of party names that match the search clues
previously entered.If the name of the party appears, select it and click
on Select name from list.  If the party’s name is not on the list or the

search returns No Person found, click on , and
enter the information requested.
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If you selected a party that is already in the database, review the party
information and be sure to select the party’s role in this filing.  Click on
the white box to the right of Role and select the correct role, i.e.,
plaintiff, defendant, etc.  If you do not select a role, it will default to a
role type of defendant.

Click on   .

Note: Party text is additional information about the party as it is
listed on the pleading (e.g., in his or her individual and official
capacity).  Party text will appear on the docket sheet next to the
party’s name.

• The next screen prompts you to select the PDF filename of the
document being filed. 

The file MUST be in a PDF format with a .pdf suffix.  If not, it will
not be accepted by the system. 

If an attempt is made to upload a non-PDF file, or make a standard
docket entry without also submitting a document, an error message will
appear.
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To Submit a PDF Document

Enter the full path name of the document to be filed in the space
provided;

or,

Click on the  button to navigate to the appropriate directory
and file to select the document.  Two very important points must be
noted here:  

If the path name for the file is manually entered, be sure to
include the drive name, if applicable, and the full directory path
(e.g., c:\docs\answr.pdf).

To use the  option, use the mouse to select the
directory in which the PDF version of the file is located.

 

Change the Files of type from

  

to

or
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Select the file to be uploaded.  

You must close the document before attempting to file it (click on
File Close or click on the “X” in the upper right corner).

(Note: To verify that the document being filed is the
correct document, after the file is selected, right click
on the file name to bring up a quick menu and left click
on open. The .pdf document will open and can be
viewed to verify that it is the correct document.)

• If there are no attachments to the motion, click on  

Attachments to Documents

All documents which form part of a pleading and which are being filed at the
same time and by the same party should be electronically filed together under
one docket number, as prescribed by the Local Rules.

• If there is an attachment to the motion (e.g., an exhibit, appendix,
accompanying proposed order, etc.): 

• Click Yes.

• Click  
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An additional screen is displayed (all exhibits must be attached to the
motion, application or document being filed) which allows you to
attach one or more documents:

NOTE: According to Local Civil Rule 5.7 an attachment or exhibit
may not be filed electronically if it exceeds 5MB. 

• At the prompt: Enter the PDF filepath and name of the
document you are filing or click on   to search for
the document.

(Note: To verify that the document being filed is the
correct document, after the file is selected, right click on
the file name to bring up a quick menu and left click on
open. The .pdf document will open and can be viewed to
verify that it is the correct document.)

• Under Type of Attachment click on the arrow and click on the
type of attachment.
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• To describe the attachment more fully or if the selections under
'Type' do not apply, click in the Description box and type in the
description.

-or-

• Click on  .

• If there are additional attachments, repeat this sequence for
each one.

• After adding all .pdf documents for attachments, click on Next.

When Attachments and Exhibits are in Paper Format

If attachments and exhibits are filed in paper format, copies must be
served on all parties in the case in the traditional manner.

Refining the Description of the Document

• Click on the drop-down list and select the correct modifier, if necessary.
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• Click on the white box to the right and type in any additional description,
if appropriate.

• Continue to click on the blank boxes to add modifiers and descriptions
of additional motions/applications, if the document contains more than
one.

• Click on     (Note: This has not yet committed the entry)

• Give final approval to the entry by following instructions on the screen.

• To modify a previous screen, click on  at the top of the browser
toolbar to find the screen to be modified.

• To abort the entry, click on Civil  to restart.
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• If the entry is correct, click on  .

After final approval is given, the next screen displays the Notice of Electronic Filing.

• This screen gives you confirmation that the system has received the
entry, the document is filed and the document is now an official Court
document.  It also tells you the date and time your transaction was
received by the Court, and the document number assigned to the
document.  For future reference, please note this number on the PDF
document file.  Scroll down to view the entire receipt.

The party filing the document should retain a paper or digital copy of the Notice of
Electronic Filing (NEF), which serves as the Court’s date-stamp and proof of filing.

• To print out the NEF, click  on the browser Toolbar.

• To save the NEF, click on File at the top of the browser screen, and
select Save Frame As...
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The NEF will list all parties being served electronically. Their names and e-mail
addresses are listed under “Notice has been electronically mailed to the following
attorneys, and no further service upon them is required if the document has
been electronically filed:” and service upon these parties is now complete.  The
NEF also lists attorneys and pro se parties that will NOT be electronically served.  If
any attorney is not a registered user of the system, it is your responsibility to serve
that attorney or pro se party in the traditional manner.  

Submitting a Proposed Order

Proposed orders may be submitted electronically or in paper form.  All
proposed orders submitted electronically must be in PDF format and
must be: (1) attached as an exhibit to a motion or stipulation; or (2)
contained within the body of a stipulation; or (3) submitted separately.
If the judge approves the proposed order, it will be re-filed electronically
under a separate document number.

Use the document attachment type of “Proposed Order” to
identify your document as 'proposed'.  Do not use the
proposed language on the document itself.

Filing Proposed Documents

If the document you wish to file requires leave of Court, such as an
amended complaint or a document to be filed out of time, the proposed
document shall be attached as an exhibit to the motion.  If leave to file
is granted, the clerk of court will electronically file your document.

Again, do not use the proposed language on the document
itself; instead, use the document attachment type of “Proposed
Document.”

Filing Other Types of Documents

To file a document other than a motion or application, make the
appropriate selection from the ‘Civil’ menu.  The screens that follow will
be very similar to those described above for filing a motion.

Documents Required on Paper

Some documents may not be filed electronically.  Other documents may
be filed electronically, but followed by a paper document.  Refer to
W.D.Mich. LCivR 5.7(d)(ii) and (iii).
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Your Account

Registered attorneys can customize their e-filing account to best suit their
needs.  You can update your contact information, add additional email
addresses, change your password, monitor cases to which you are not a party
and modify how you receive electronic notifications.  To make any changes or
updates to your account, select Utilities from the blue menu bar and then
select Maintain Your Account.

Once you access your account, you will see the screen below that contains
your contact information. **Note: if it is necessary to change any of the listed
information, please contact the Clerk's office to notify them of the change to
ensure your contact information is updated in their records as well.
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Your Password

A registered attorney may change the Court-assigned password on his
or her account by selecting More User Information from the account
screen.

To change your password, delete the ***** to the right of 'Password.'
Type your new password and hit Return to Account Screen.  Once
you are back to the account screen, click Submit.  Click Submit one
more time to commit the transaction.  Once you have changed your
password, not even the Court will have access to it.

If you forget your password, contact the ECF Help Desk at (616) 456-
2206 or toll free at (800) 290-2742.  For security reasons, this
information will not be released to third-parties.  The attorney on the
account is the only person to whom the Court will release this
information.

IMPORTANT: Do NOT change your assigned Login!

Email Addresses

All registered attorneys have an affirmative duty to inform the Clerk
immediately of any change in their email address. 

If you wish to update the email address(es) listed on your account,
select Email Information from the account screen.  You can
change/update an email address by deleting the information listed and
adding the new email address(es).
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The Court recommends that you set up a secondary
email address that is either (1) a central repository
address that several people have access to, and/or (2)
the email address of someone that works closely with
you in all your cases (secretary, legal assistant,
paralegal).  This is a safeguard to ensure that nothing
is missed.  Should you be out for the day, on vacation,
etc., having a secondary email address entered on your
account ensures that someone else will also get the
message.

To add a secondary email address to your account, check the box to
the left of 'to these additional addresses.'  Enter the additional email
address(es) in the white box to the right.  Click Return to Account
Screen and then Submit.  Click Submit one more time to commit the
change.

Monitoring Other Cases

If you would like to monitor cases to which you are not a party, from the
account screen select Email Information.  Click on the box to the left
of “Send notices in these additional cases.”  Type the case numbers of
the cases you want to monitor in the box to the right.  Click Return to
Account Screen and then Submit. Click Submit one more time to
commit the change.  You will then be notified of activity in the cases you
requested.
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Displaying a Docket Sheet

Click on Reports.

This displays the Reports Menu, listing the reports that can be produced.

• Click on Docket Sheet.
• Enter the case number.
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• Specify the appropriate criteria for your docket sheet (if you do
not enter specific filed/entered dates or document numbers, the
entire docket sheet will display).

• Click on Include Links to Notice of Electronic Filing to view
the Notice of Electronic Filing for each document.

• Scroll down and click on .

The computer displays the docket sheet.

You may scroll through by using the up and down arrows on the bar to
the right of the list.

If you want to view an actual document described on the docket sheet,
click on the document number.
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If you want to view the Notice of Electronic Filing, click on the gray dot
next to the document number. 

You may print out the document by clicking  on the browser
toolbar.

To return to the docket sheet, click on  .

You may print out the docket sheet by clicking  on the browser
toolbar.

Displaying Other Reports

To view a report other than a docket sheet, make the appropriate selection
from the Reports Menu.  The steps that you follow are very similar to those
described above for viewing a docket sheet.

Known Problems and Troubleshooting

Known Problems

Converting documents to PDF 

 If WordPerfect 5.1 or 7.0 is used to write the document, and the
document is more than three pages, Adobe Acrobat will not convert all
pages to the PDF format. The converted document will have missing
pages.  Use Adobe Exchange to ensure the integrity of the converted
PDF document.  

Cannot log into the LIVE SYSTEM

A session can only be established using Netscape or Internet Explorer
(please refer to our website for the updated list of compatible versions)
to do e-filings.
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If  your Login and Password have both been correctly typed (in all
lowercase letters), and you still cannot log into the system, please call
the Court’s ECF Help Desk at (616) 456-2206 or toll free at (800) 290-
2742, or email ecfhelp@miwd.uscourts.gov.

To ensure the documents transmitted have arrived in their entirety, it is
important to read the document after it is received by the Court.  This
can be done by viewing the docket sheet for the case and selecting the
transmitted document.  The document number of the transmitted
document appears on your notice of electronic filing (NEF) receipt.

Trouble-shooting Hints

If your Login or Password is not accepted, please ensure that they are typed
correctly. The logins and passwords are case-sensitive and must be in all
lowercase letters.

Technical Failures

The Clerk shall deem the public ECF Web site to be subject to a technical
failure on a given day if the site is unable to accept filings continuously or
intermittently over the course of any period of time greater than one hour after
12:00 noon (Eastern Time) that day, in which case filings due that day which
were not filed due solely to such technical failures shall become due the next
business day.  Such delayed filings must be accompanied by a declaration or
affidavit attesting to the filer’s failed attempts to file electronically at least two
times after noon separated by at least one hour on each day of delay because
of such technical failure (see sample on following page).  If you experience
difficulty filing a document electronically the initial point of contact should be the
Court’s ECF Help Desk at (616) 456-2206 or toll free at (800) 290-2742.  You
can also email the Help Desk  at ecfhelp@miwd.uscourts.gov.
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S A M P L E    F O R M A T

)
)

Plaintiff ) Case No.
)

v. ) Judge
)

Defendant ) Declaration/Affidavit that [Party] was
) Unable to File in a Timely Manner
) Due to Technical Failures
)

Please take notice that [Plaintiff/Defendant, Name of Party] was unable to file the
attached [Title of Document] in a timely manner due to technical failures as set forth in W.D.
Mich. LCivR 5.7(d)(v). The deadline for filing the [Title of Document] was [Filing Deadline
Date]. The reason(s) that I was unable to file the [Title of Document] in a timely manner and
the good faith efforts I made prior to the filing deadline to both file in a timely manner and to
inform the Court and the other parties that I could not do so are set forth below. 

[Statement of reasons and good faith efforts to file and to inform (including dates and
times)]

I declare under penalty of perjury that the foregoing is true and correct.

Respectfully submitted,

/s/ [Registered Attorney]
Name of Registered Attorney [attorney bar number]
Address
City, State, Zip Code
(xxx) xxx-xxxx [telephone number]
xxxxx@xxxxxxxxx [e-mail address]



E-FILING REGISTRATION FORM

The information contained in this box will be used for security/confirmation purposes related to your e-filing login/password:

Key word/phrase: _________________________________     Reminder: ___________________________________________

COURT USE ONLY:

 E-Filing Login Assigned:  ____________________

 E-Filing Password Assigned: _________________

 9 Confirm ation e-m ail sent 9 E-m ail confirm ed by attorney

 9 Attorney's record updated 9 UR registered e-m ail sent  
 9 Copy of form  m ailed to attorney

UNITED STATES DISTRICT COURT  

FOR THE WESTERN DISTRICT OF MICHIGAN

**Please type; this will also serve as a return mailing label**

Name: _______________________________
Firm: _______________________________
Addr.: _______________________________

_______________________________
_______________________________

Phone: ____________________
_ _

State Bar Number: _______________________
           (and state, if not Michigan)

Date of admission to the Bar of this court: _______

**NOTE:  A PACER ACCOUNT IS NECESSARY
FOR VIEWING ELECTRONIC DOCUMENTS**

This form cannot be submitted electronically.
Complete the form on-line, print a hard copy, sign it
and present it to the Clerk's office at the address
below.  A login and password for access to the
electronic case filing system will be issued to you
upon receipt of the fully-completed form.  All of this
information is required and must be supplied,
including your original signature.

Primary e-mail address: ______________________
        (Attorney's e-m ail for electronic service)

Secondary e-mail address:____________________
(Central repository, Secretary, etc.)

     

E-mail software used:  _______________________
(i.e., O utlook, G roupwise, etc.)

� I have an existing PACER account.
� My firm has an existing PACER account.

� I already have an ECF login that I use in_______________________________, which is_____________;
(Nam e of O ther District) (Login)

please assign the same login for my use in the Western District of Michigan.

BY COM PLETING THIS FORM , ATTORNEYS CERTIFY THAT THEY ARE M EM BERS IN GOOD STANDING OF THE BAR OF THIS COURT AND

THAT THEY ARE FAM ILIAR WITH W.D. M ich. LCivR 5.7 and LCrR 49.10, AS APPLICABLE TO THEIR PRACTICE, WHICH M AY BE FOUND AT:

www.miwd.uscourts.gov

By registering under this rule, attorneys consent to electronic service of all electronically filed documents.  See
W.D. Mich. LCivR 5.7(i)(ii) and LCrR 49.10(h)(ii).

Attorney's Signature:  

Return this form via hand delivery
or via U.S. mail only  to:

Clerk, U.S. District Court
E-Filing Registration
399 Federal Building
110 Michigan St., N.W.
Grand Rapids, MI  49503

YOUR E-FILING LOGIN AND PASSWORD
WILL BE SENT TO YOU VIA U.S. MAIL
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